2. Create and manage documents

In this chapter
m Create documents

m Open and move around in documents
m Display different views of documents

m Display and edit file properties

m Save and close documents

Practice files

For this chapter, use the practice files from the Word2016SBS\Ch02
folder. For practice file download instructions, see the introduction.

You can use Word 2016 to create many different types of documents, for many
different purposes. Word is widely used in schools, businesses, and
organizations of many kinds to create letters, newsletters, reports, resumes, and
other documents that contain text. Word provides a lot of flexibility in document
design, so you can also create documents that contain images and content that
doesn’t fit a standard sheet of paper, such as trifold brochures, greeting cards,
business cards, certificates, and signs.

You can open and work with documents from a variety of locations. Word 2016
introduces methods of quickly accessing documents from multiple computers
that can save you time and conserve storage space. When working in a Word
document, you can display different views of the content and the document
structure, and use different methods to move around within the document. You
can also display and modify the information that is stored with each file (its
properties).

This chapter guides you through procedures related to creating documents,
opening and moving around in documents, displaying different views of
documents, displaying and editing file properties, and saving and closing
documents.

Create documents
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when creating a document 1n Word, you can create a blank document ot the
default file type or create a document based on one of the templates provided
with Word. Each template incorporates specific design elements such as fonts
and colors. Many templates also include typical information that you can modify
or build on to create a useful document.

When you start Word, the app displays a Start screen that gives you options for
opening an existing file or creating a new one.
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The Start screen appears by default but can be disabled

If you create custom templates and save them in your Personal Templates folder,
Featured and Personal links appear below the search box. You can click these
links to switch between viewing app-supplied templates and your own.



| @ SEE ALSO

For information about creating custom templates, see “Create and
attach templates” in Chapter 15, “Create custom document
elements.”

| @TIP

The document templates that are available in Word include standard
templates that have been available for many years, and featured
templates that change occasionally. The templates on the New page
of the Backstage view in your installation of Word might be
different from those shown in images in this book.

If you’re already working in Word, you can create a new document from the
New page of the Backstage view. The same templates and search options are
available from both pages.
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Word provides document templates for a wide variety of purposes

You can start from a blank document that contains one page. You can then add
content, apply structure and design elements, and make any necessary
configuration changes.

New blank documents are based on the built-in Normal template. You can save
time by basing your document on a content template, and then customizing the
content provided in the template to meet your needs.

Many templates are available when you’re working in Word 2016. Most are for
specific types of documents, and many are pre-populated with text, tables,
images, and other content that you can modify to fit your needs. A few of the
templates are installed on your computer with Word. Many more templates are
maintained on the Microsoft Office website, but you can locate and use them
directly from within Word (provided you have an Internet connection).

The available tempblates varv depending on whether vou’re working online or



offline:
m When you’re working online (that is, when your computer has an active

Internet connection, whether or not you’re using it to do anything else), the
New page displays thumbnails of featured templates. These vary based on
the season; for example, they might include holiday-specific or season-
specific templates for creating announcements, invitations, and
newsletters. The search box at the top of the page is active; you can enter a
search term to display related online templates, or click a category below
the search box to display online templates in that category.

m When you’re working offline, the New page displays only templates that
are stored on your computer. These include any templates that you have
already used, and a selection of letter, newsletter, report, and resume
templates. The search box is unavailable (you can only search the offline
templates by scrolling through the thumbnails on the New page).

Word document templates contain elements such as the following:

m Formatting Most templates contain formatting information, which in
addition to styles can include page layout settings, backgrounds, themes,
and other types of formatting. A template that contains only formatting
defines the look of the document; you add your own content.

m Text Templates can also contain text that you customize for your own
purposes. For example, if you base a new document on an agenda template
from Office.com, the text of the agenda is already in place, and all you
have to do is customize it. Sometimes, a document based on a template
displays formatted text placeholders surrounded by square brackets—for
example, [Company Name]—instead of actual text. You replace a
placeholder with your own text by clicking it and then typing the
replacement. If you don’t need a placeholder, you can simply delete it.

m Graphics, tables, charts, and diagrams Templates can contain ready-
made graphic elements, either for use as is or as placeholders for elements
tailored to the specific document.

m Building blocks Some templates make custom building blocks, such as
headers and footers or a cover page, available for use with a particular type
of document. They might also include AutoText, such as contact
information or standard copyright or privacy paragraphs.

| @ SEE ALSO



For information about working with building blocks, see “Insert
preformatted document parts” in Chapter 9, “Add visual elements,”
and “Create custom building blocks” in Chapter 15, “Create custom
document elements.”

m Custom tabs, commands, and macros Sophisticated templates might
include custom ribbon tabs or toolbars with commands and macros that are
specific to the purposes of the template. A macro is a recorded series of
commands that permits a user to perform a process with the click of a
button. The topic of macros is beyond the scope of this book; for
information, refer to Word Help.

| @TIP

Word 2016 template files have one of two file name extensions,
depending on their content. Those that contain macros have the
.dotm file name extension; those that don’t contain macros have the
.dotx extension.

When you base a new document on a template, that template is said to be

attached to the document. The styles defined in the attached template appear in
the Styles pane so that you can easily apply them to any content you add to the
document. You can change the document template by attaching a different one.

| @ SEE ALSO

For information about attaching templates to existing documents,
see Chapter 15, “Create custom document elements.”

To create a new blank document

1. Start Word.

2. When the Start screen appears, press the Esc key.
Or

1. If Word is already running, click the File tab to display the Backstage
view.

2. In the left pane of the Backstage view, click New to display the New page.
3. On the New page of the Backstage view, click the Blank document



thumbnail.

To preview design templates
1. Display the New page of the Backstage view.

2. On the New page, scroll the pane to view the design templates that were
installed with Word.

3. Click any thumbnail to open a preview window that displays a sample
document page.

4. Do any of the following:

* To create a document based on the template that is active in the preview
window, click the Create button.

 To view the next template, click the arrow to the right of the preview
window; to view the previous template, click the arrow to the left.

* To close the preview window without creating a document, click the
Close button in the upper-right corner of the preview window.
To create a document based on an installed template
1. Display the New page of the Backstage view.
2. Scroll the pane to locate the design you want to use.
3. Double-click the thumbnail to create the document.

To create a document based on an online template
1. Display the New page of the Backstage view.
2. Do either of the following to display templates related to a specific topic:

* In the search box at the top of the page, enter a term related to the
template content or design you’re looking for, and then click the Search
button.

* Below the search box, click one of the suggested searches.

3. In the Category list, click any category or categories to further filter the
templates. Active category filters are indicated by colored bars at the top of
the Category list.
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Clicking multiple categories applies multiple filters

4. Scroll the pane to locate a design that fits your needs.
5. Double-click any thumbnail to create a file based on the template.

To remove a template search filter
1. Do either of the following:

* In the Category list, point to the applied filter, and then click the X that
appears to the right of the category name.

* Double-click the category name.

To clear a template search
1. To the left of the search box, click the Home button.

Open and move around in documents

The Start screen that appears by default when you start Word displays a list of
documents you worked on recently, and a link to open other existing documents.

Open existing documents

If the document you want to open appears on the Start screen, you can open it
directlv from there. Otherwise. vour can onen docuiments that are stored locallv
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on your computer, or in a remote storage location such as a Microsoft OneDrive
folder or a Microsoft SharePoint document library, either from within Word or
from the document storage location.

| @TIP

If you receive a document as an attachment to an email message,
you can open the attached document and start Word, if it isn’t
already running, from within Outlook 2016, or you can preview the
document content directly in the Outlook Reading pane without

starting Word.
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Recover Unsaved Documents

The Open page includes all the locations you’ve linked to from Office apps

The Open page displays only documents that are saved in the Word-specific file
formats (.docx and .doc), and templates created for those standards. For more
information about file formats, see “Save and close documents” later in this
chapter.



The Recent list in the right pane of the Open page provides quick access to the
documents you’ve worked with recently. The Recent list includes locally stored
documents and documents that you’ve worked with while signed in with your
current account on any computer, tablet, or other device, if the documents are
stored in a shared location. This is one of the tremendous benefits of the Office
365 subscription model and the cloud storage that comes with it—you can be up
and running on a new computer in minutes, without having to move files or
configure settings and preferences. If you use multiple computers, you can use
this very convenient feature to seamlessly transition between computers without
having to actually transport files (on a USB flash drive or hard drive) or maintain
multiple copies of files in different locations.

| @ SEE ALSO

For more information about Office 365, see the sidebar “About
Office” in Chapter 1, “Word 2016 basics.”

To ensure that you can find a specific document quickly regardless of whether
you’ve worked with it recently, you can pin it to the Recent list. Pinned files
appear in the Pinned section at the top of the list and are indicated by a
thumbtack.

Open documents in Protected view

When you open a document from an online location (such as a
cloud storage location or email message) or from a location that has
been deemed unsafe, Word opens the file in Protected view, with
most editing functions disabled. The purpose of this is to prevent
any malicious code from gaining access to your computer. If you’re
uncertain about the origin of a file that you’re opening, you can
choose to open the file in Protected view.

In Protected view, the title bar displays Read-Only in brackets to the
right of the file name, and a yellow banner at the top of the content
pane provides information about why the file has been opened in
Protected view. If you know that the document is from a safe
location or sender, and you want to edit the file content, you can
choose to enable editing. If you don’t intend to modify the file
content, you can hide the banner by clicking the Close button (the
X) at its right end.



If you want to open documents from a specific online storage folder
without going into Protected view, you can add that folder (and its
subfolders, if you want) to your Trusted Locations list. For
information about trusted locations and other Trust Center settings,
see “Manage add-ins and security options” in Chapter 16,
“Customize options and the user interface.”

To open a recent document
1. Start Word.

2. On the Start screen, in the Recent list, click the file name of the file you
want to open.

Or

1. With Word running, click the File tab to display the Backstage view.

2. In the left pane of the Backstage view, click Open to display the Open
page.

3. With Recent selected at the top of the left pane of the Open page, scroll
the file list in the right pane if necessary to locate the document you want
to open. Then click the file name to open it.

To pin a document to the Recent file list
1. Display the Recent list on the Open page of the Backstage view.
2. If necessary, scroll through the list to locate the file you want to pin.

3. Point to the file name, and then click the Pin button that appears to the
right of the file name to add the file to the Pinned area at the top of the
Recent list.

To open any existing document

1. Start Word.

2. Do either of the following to display the Open page of the Backstage
view:

* On the Start screen, at the bottom of the left pane, click Open Other
Documents.
» With Word running, display the Backstage view, and then click Open.

3. In the Places list, click the local or network storage location where the file
is stored.
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4. Navigate to the file storage folder by using one of the following methods:

« In the right pane, click a recent folder. Then click any subfolders until
you reach the folder you want.

* In the left pane, click Browse to open the Open dialog box. Then click
folders in the Navigation pane, double-click folders in the file pane, or
enter the folder location in the Address bar.

5. Double-click the document you want to open.

| @TIP

In the Open dialog box, clicking a file name and then clicking the
Open arrow displays a list of alternative ways to open the selected
document. To look through a document without making any
inadvertent changes, you can open the document as read-only, open
an independent copy of the document, or open it in Protected view.
You can also open the document in a web browser. In the event of a
computer crash or other similar incident, you can tell the app to
open the document and try to repair any damage.

To open a file directly from a OneDrive storage site
1. In your browser, navigate to the OneDrive folder.
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Z. browse to and click the t1le you want to open.

3. If prompted to do so, enter the Microsoft account credentials associated
with your OneDrive, and then click Sign in.

Or

1. In File Explorer, navigate to the OneDrive folder.
2. Browse to and double-click the file you want to open.

3. If prompted to do so, enter the Microsoft account credentials associated
with your OneDrive, and then click Sign in.

Edit PDF files in Word

A useful feature of Word 2016 is the ability to open PDF files and
edit them by using all the standard Word proofing tools. When you
finish, you can save the file as a document or as a PDF.

To open a PDF file in Word, do either of the following:

m In File Explorer, right-click the file, click Open, and then click
Word (Desktop).

m In Word, display the Open page of the Backstage view, navigate
to the file location, click the file, and then click Open. (In the
Open dialog box, PDF files now fall into the category of Word
Documents.)

Word converts the file to an editable Word document. If the file
contains complicated formatting and layout, the Word version of the
document might not be a perfect replica of the PDF, but most
simple files convert quite cleanly.

Move around in documents

If you open a document that is too long or too wide to fit in the content pane,
you can bring off-screen content into view without changing the location of the
cursor by using the vertical and horizontal scroll bars. The scroll bars appear
only when the document is longer or wider than the content pane. The scroll bars
and pointer fade from sight when you’re not using the mouse, to remove
distractions. You can make them reappear by moving the mouse.

You can also move around in a document by moving the cursor. You can place
the cursor in a specific location by clicking there, or you can move the cursor
different distances and in different directions and by pressing keyboard keys.
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bar displays the page the cursor is on, but you can also display the cursor’s
location by section, line number, and column, and in inches from the top of the

page.

| @ SEE ALSO

For information about displaying information on the status bar, see
“Work with the ribbon and status bar” in Chapter 1, “Word 2016
basics.”

In a long document, you might want to move quickly among elements of a
certain type; for example, from heading to heading, from page to page, or from
graphic to graphic. You can do this from the Navigation pane.
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Move to the next object of a specific type

| @ SEE ALSO

For information about working in the Navigation pane, see “Display
different views of documents,” later in this chapter.

A greater variety of browsing options is available from the Go To tab of the Find
And Replace dialog box. From this tab, you can locate pages, sections, lines,
bookmarks, comments, footnotes, endnotes, fields, tables, graphics, equations,
objects, or headings. You can jump directly to a specific object if you know its



position within the sequence of that type of object in the document (for example,
if it is the fifth equation), move forward or backward a specific number of
objects, or browse from one to the next.
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| @ SEE ALSO

For information about using the Navigation pane to search for
specific content in a document, see “Find and replace text” in
Chapter 3, “Enter and edit text.”

To change the area of a document that is displayed in the content pane
1. On the vertical scroll bar, do any of the following:
* Click the scroll arrows to move up or down by one line.

* Click above or below the scroll box to move up or down by the height of
one screen.

* Drag the scroll box on the scroll bar to display the part of the document
corresponding to the location of the scroll box. For example, dragging
the scroll box to the middle of the scroll bar displays the middle of the
document.

Or
1. On the horizontal scroll bar, do any of the following to move side to side:
* Click the scroll arrows.
* Click to the left or right of the scroll box.

* Drag the scroll box on the scroll bar to display the part of the document
corresponding to the location of the scroll box.



'1'o0 move the cursor by using the keyboard keys

1. Move the cursor by pressing the key or key combination described in the

following table.
To move the cursor Press
Left one character Left Arrow
Right one character Right Arrow
Up one line Up Arrow
Down one line Down Arrow
Left one word Ctrl+Left Arrow
Right one word Ctrl+Right Arrow
Up one paragraph Ctrl+Up Arrow
Down one paragraph Ctrl+Down Arrow
To the beginning of the current line Home
To the end of the current line End
To the beginning of the document Ctrl+Home
To the end of the document Ctrl+End
To the beginning of the previous page Ctrl+Page Up
To the beginning of the next page Ctrl+Page Down
Up one screen Page Up
Down one screen Page Down

To show or hide the Navigation pane in a document
1. On the View tab, in the Show group, select the Navigation Pane check
box.
To browse by object from the Navigation pane
1. Open the Navigation pane, and then do any of the following:

* At the top of the Navigation pane, click Headings. Then click any
heading to move directly to that location in the document.

« At the top of the Navigation pane, click Pages. Then click any



thumbnail to move directly to that page of the document.

* At the right end of the search box, click the arrow. In the Find list, click
the type of object you want to browse by. Then click the Next and
Previous arrows to move among those objects.

To display the Go To tab of the Find And Replace dialog box

1. Do any of the following:

* On the Home tab, in the Editing group, click the Find arrow, and then
click Go To.

* In the Navigation pane, click the Search arrow, and then in the Search
for more things list, click Go To.

* Press Ctrl+G.

To browse by object from the Go To What list
1. Display the Go To tab of the Find and Replace dialog box.
2. In the Go to what list, click the type of object you want to search for.
3. Do any of the following:
* Click the Next button to move to the next object of that type.
* Click the Previous button to move to the previous object of that type.

* In the adjacent box, enter either of the following, and then click the Go
To button:

* Enter a number identifying the position of the object within the total
objects of that type in the document. (For example, to move to the
fourth field in the document, you would enter 4.)

* Enter + (plus sign) or — (minus sign) and then a number to move
forward or backward by that many objects of the selected type.

Display different views of documents

You can display a document in different views that provide different types of
information and make it easier to interact with specific document elements. If
you want to take a closer look at the document content, you can increase the
magnification of the content pane. If you want a high-level view of the content—
for example, to quickly review all the pages of a document for length—you can
decrease the magnification and view multiple pages at the same time.

Word 2016 has five views in which you can create, organize, and preview
documents. Each view is suited to a specific purpose. The views are:



m Print Layout view This view displays a document on the screen the way it
will look when printed. You can review elements such as margins, page
breaks, headers and footers, and watermarks. This is the default view and
the view you’ll use most frequently (or perhaps the only view you’ll use)
when developing content.

m Read Mode view This view displays as much document content as will fit
on the screen at a size that is comfortable for reading. In this view, the
ribbon is replaced by one toolbar at the top of the screen with buttons for
searching and navigating in the document. You can display comments, but
you can’t edit the document in this view.

m Web Layout view This view displays the document the way it will look
when viewed in a web browser, so that you can review the way that text
wraps to fit the window and the positioning of graphics. Web Layout view
also displays page backgrounds and effects.

m Outline view This view displays the structure of a document as nested
levels of headings and body text, and provides tools for viewing and
changing the hierarchy.

| @ SEE ALSO

For information about displaying and modifying a document in
Outline view, see “Reorganize document outlines” in Chapter 10,
“Organize and arrange content.”

m Draft view This view displays the content of a document with a simplified
layout so that you can quickly enter and edit text. Draft view doesn’t
display images or layout elements such as headers and footers.

You manage the display of views and of window elements from the View tab of
the ribbon. Three of the views are also available from the View Shortcuts toolbar
near the right end of the status bar.
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When you are developing a document in Print Layout view, the primary content
pane displays the content of the document that you’re working in. Each page is
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represented at the size specitied In the document layout settings, with margins
and other white space represented as they will appear when the document is
printed. As you scroll a multipage document, spaces appear between the pages.
If you want to fit more content on the screen, you can hide the white space on
and between pages.
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The junction of two pages with and without white space

When working in Outline or Draft view, you can display the paragraph style of
each paragraph in the left margin, in an area called the style area pane. (It’s not a
pane, though, it’s just a marginal area of the page.) By default, the style area
pane width is set to zero inches wide, so it is effectively closed. If you want to
display it, you can increase the width.
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The style area pane is available only in Draft view and Outline view

If your document uses styles to control the appearance and hierarchy of the
content, you can display the headings in the Navigation pane and styles in the
Style pane so that you can more quickly access and work with styles and styled
content. You can also use the Navigation pane to display and move among page
thumbnails or search results, as described in the previous topic.

Word has many other task-specific panes in which you can, for example, display
Clipboard content, research terminology, review spelling, and format graphics.
These panes usually appear to the right or left of the content pane and span the
full height of the content pane. Some of them can float within or outside of the
Word window or be docked to other sides of the window. I discuss these panes
in the context of their functionality in other chapters. Regardless of the purpose
of the pane, however, you use the same methods to resize or move it.

You can change the space available for document content and app window
elements by resizing the window, adjusting the relative sizes of the panes, or



collapsing or hiding the ribbon. A new feature introduced with Word 2016
permits you to entirely hide not only the ribbon content, but also the ribbon tabs
and the app window title bar.

| @ SEE ALSO

For information about hiding, collapsing, and displaying the ribbon,
see “Work with the ribbon and status bar” in Chapter 1, “Word
2016 basics.”

When you want to focus on the layout of a document, you can display rulers and
gridlines to help you position and align elements. You can also adjust the
magnification of the content area by using the tools available in the Zoom group
on the View tab and at the right end of the status bar.

Zoom slider Zoom button
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Zoom to
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Clicking the Zoom button opens the Zoom dialog box

| @ SEE ALSO

For information about controlling paragraph formatting from the
ruler, see “Apply paragraph formatting” in Chapter 4, “Modify the




structure and appearance of text.”

If you want to work with different parts of a document, you can open the same
instance of the document in a second window and display both, or you can split a
window into two panes and scroll through each pane independently.

You’'re not limited to working with one document at a time. You can easily
switch among multiple open documents. If you want to compare or work with
the content of multiple documents, you can simplify the process by displaying
the documents next to each other.

A feature that can be invaluable when you are fine-tuning the layout of a
document in Word is the display of nonprinting characters (such as tabs,
paragraph marks, and section breaks) that control the layout of your document.
You can control the display of these characters for each window.
To switch among views of a document
1. Do either of the following:
* On the View tab, in the Views group, click the view you want.

* On the View Shortcuts toolbar, click the view button you want.

To hide or display white space in Print Layout view
1. Point to the space between two pages.
2. When the pointer changes to display a representation of that space,
double-click.
To show or hide the Navigation pane
1. On the View tab, in the Show group, select the Navigation Pane check
box.
To adjust the size of the Navigation pane

1. Point to the right border of the Navigation pane. When the pointer
changes to a double-headed arrow, drag to the right or left.

| @TIP

The Navigation pane is available in all views other than Read Mode.
When you adjust the width of the Navigation pane, the pane content
changes accordingly. For example, the Navigation pane displays
more page thumbnails in a narrow pane and fewer page thumbnails
in a wide pane.




To display the style area pane in Draft view or Outline view

1. In the Backstage view, click the Options page tab to open the Word
Options dialog box.

2. In the Word Options dialog box, click the Advanced page tab.

3. On the Advanced page, scroll to the Display area (about halfway down
the page) and change the Style area pane width in Draft and Outline
views setting to any number greater than 0. Then click OK.

To resize the style area pane in Draft view or Outline view

1. Point to the right border of the style area pane.

2. When the pointer changes to a double-headed arrow, drag the border to the
left or right.

To change the magnification of document content

1. Do either of the following to open the Zoom dialog box:

* On the View tab, in the Zoom group, click the Zoom button.
* At the right end of the status bar, click the Zoom button.

2. In the Zoom dialog box, select a Zoom to option or enter a specific
percentage in the Percent box, and then click OK.

Or

1. In the zoom controls at the right end of the status bar, do any of the
following:

* Drag the slider to the left to decrease the magnification or to the right to
increase the magnification.

At the left end of the slider, click the Zoom Out button to decrease the
magnification in 10-percent increments.

* At the right end of the slider, click the Zoom In button to increase the
magnification in 10-percent increments.
To display or hide rulers or gridlines in a document
1. On the View tab, in the Show group, do either of the following:
* Select or clear the Ruler check box.
* Select or clear the Gridlines check box.




@ SEE ALSO

For information about controlling document gridlines, see “Arrange
objects on a page” in Chapter 10, “Organize and arrange content.”

To display or hide nonprinting characters and formatting marks in a
document

1. Do either of the following:

* On the Home tab, in the Paragraph group, click the Show/Hide q
button.

* Press Ctrl+*.

| @TIP

You need to hold down the Shift key to activate the * key. So, in
effect, you are pressing Ctrl+Shift+8.

To split a window into two panes
1. On the View tab, in the Window group, click the Split button.

To display a different open document
1. Do either of the following:

* On the View tab, in the Window group, click the Switch Windows
button, and then click the file you want to view.

* Point to the Word button on the Windows taskbar, and then click the
thumbnail of the document you want to display.
To display multiple open documents at the same time
1. On the View tab, in the Window group, click the Arrange All button.

Display and edit file properties

Properties are file attributes or settings, such as the file name, size, created date,
author, and read-only status. Some properties exist to provide information to
computer operating systems and apps. You can display properties within the
content of a document (for example, you can display the page number on the
document pages). Word automatically tracks some of the file properties for you,
and you can set others.

You can examine the properties that are attached to a file from the Info page of



the Backstage view.
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Some of the properties stored with a typical Word document

You can change or remove basic properties in the default Properties pane or
expand the Properties pane to make more available, or you can display the
Properties dialog box to access even more properties.
To display file properties
1. Display the Info page of the Backstage view. The Properties area in the
right pane displays the standard properties associated with the document.

2. At the bottom of the Properties pane, click Show All Properties to
expand the pane.

3. At the top of the Properties pane, click Properties, and then click
Advanced Properties to display the Properties dialog box.

To edit file properties
1. In the Properties pane, click the value for the property you want to edit to



activate the content box.
2. Enter or replace the property value, and then press Enter.

Or

1. In the Properties dialog box, do either of the following:

* On the Summary page, click the box to the right of the property you
want to modify, and then enter or replace the property value.

* On the Custom page, select the property you want to modify in the
Name list, and then enter or replace the property value in the Value box.

Save and close documents

When you save a document in Word, it is saved in the default .docx file format,
but you can also choose a different format from many other choices. For
example, if you plan to distribute the document electronically to people who use
a different word-processing program, you can choose a compatible format, or if
you want to protect the document content, you can save it as a PDF file.

Manually save documents

You save a document the first time by clicking the Save button on the Quick
Access Toolbar or by displaying the Backstage view and then clicking Save As.
Both actions open the Save As page, where you can select a storage location.
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Save your document in an online location to access it from anywhere

You can save the document in a folder on your computer or, if you have an
Internet connection, in a folder on your OneDrive. If your company is running
SharePoint, you can add a SharePoint site so that it is available from the Places
pane of the Save As page, just like any other folder.

| @ SEE ALSO

For information about OneDrive, see the sidebar “Save files to
OneDrive” later in this chapter.

Clicking Browse at the bottom of the left pane displays the Save As dialog box,
in which you assign a name to the document.
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| @TIP

If you want to create a new folder in which to store the document,
click the New Folder button on the dialog box’s toolbar.

After you save a document for the first time, you can save changes simply by
clicking the Save button on the Quick Access Toolbar. The new version of the
document then overwrites the previous version.

To save a document for the first time

1. Click the File tab to display the Backstage view.
2. In the left pane of the Backstage view, click Save As.

3. On the Save As page of the Backstage view, click a storage location, and
then click a recently accessed folder in the right pane, or click Browse.

4. In the Save As dialog box, browse to the folder you want to save the

document in.




5. In the File name box, enter a name for the document.

6. If you want to save a document in a format other than the one shown in the
Save As Type box, click the Save as type arrow and then, in the Save as
type list, click the file format you want.

7. In the Save As dialog box, click Save.

To add a cloud storage location
1. On the Save As page of the Backstage view, click Add a Place.
2. In the Add a Place list, click Office 365 SharePoint or OneDrive.

3. In the Add a service dialog box, enter the email address you use to sign in
to the cloud storage service, and then click Next.

4. In the Sign in dialog box, enter the password associated with the account,
and then click Sign In to add the cloud storage location associated with
that account to the Places list.

To save a copy of a document

1. Display the Save As page of the Backstage view.

2. Save the document with a different name in the same location or with any
name in a different location. (You can’t store two documents with the
same name in the same folder.)

To save a document without changing its name or location

1. Do any of the following:

* On the Quick Access Toolbar, click the Save button.
* In the left pane of the Backstage view, click Save.
* Press Ctrl+S.

Save files to OneDrive

When you save a document to OneDrive, you and other people with
whom you share the document can work on it by using a local
installation of Word or by using Word Online, which is available in
the OneDrive environments.

If you’re new to the world of OneDrive, here’s a quick tutorial to
help you get started.

OneDrive is a cloud-based storage solution. The purpose of
OneDrive is to provide a single place for you to store and access all
vour files. Although this might seem like a simple concept, it



provides major value for people who use Word or other Office
products on multiple devices, including Windows computers, Mac
computers, iPads and other tablets, and Windows, iPhone, and
Android smartphones.

For example, you can create a document on your desktop computer
at work, edit it on your laptop at home, and review it on your
smartphone while you’re waiting for your lunch to be served at a
restaurant. If you use the full suite of Office products within your
organization, you can even present the document in a Skype for
Business meeting from your tablet PC, all while the document is
stored in the same central location.

There are currently two types of OneDrive—one for personal use
and one for business use:

m OneDrive A personal OneDrive storage site is provided free
with every Microsoft account. Each OneDrive is linked to a
specific account.

m OneDrive for Business An organizational OneDrive storage
site is provided with every business-level Office 365
subscription license. These storage locations are part of an
organization’s Office 365 online infrastructure.

You might have both types of OneDrive available to you; if you do,
you can connect to both from within Word (or any Office app).

In this book, the personal and organizational versions are referred to
generically as OneDirive sites.

To make OneDrive a realistic one-stop storage solution, Microsoft
has chosen to support the storage of very large files (up to 10
gigabytes [GB] each) and to provide a significant amount of free
storage—from a minimum of 15 GB for every Microsoft account, to
unlimited storage for Office 365 subscribers!

By default, documents that you store on your OneDrive site are
password-protected and available only to you. You can share
specific files or folders with other people by sending a personalized
invitation or a generic link that allows recipients to view or edit
files. You can access documents stored on your OneDrive in several
ways:



m From within Word when opening or saving a file.

m Through File Explorer, when you synchronize your OneDrive
site contents with the computer.

m Through a web browser. Personal OneDrive sites are available at
https://onedrive.live.com; organizational OneDrive sites have
addresses linked to your Office 365 account, such as
https://contoso-my.sharepoint.com/personal/joan_contoso_cony.

Because OneDrive and OneDrive for Business file storage locations
are easy to add to any version of Word 2016, OneDrive is a simple
and useful cloud storage option. And best of all, it’s completely
free!

Automatically save documents

By default, Word automatically saves the document you’re working on and
tracks saved versions so that you can gracefully recover documents without
losing data, or you can revert to an earlier version.

When the AutoSave function is turned on:
m If you’re working in a new, unnamed file, the app saves a temporary copy
of the file to your default storage location.

m If you’re working in a previously saved file, the app saves a copy of the
file to the location in which you opened or last saved it.

You can turn off the automatic file-saving function if you prefer to save changes
manually (but I'd advise against it), and you can change the time interval
between saves.

To adjust the time interval between saves
1. Display the Backstage view, and then click Options to open the Word
Options dialog box.
2. In the left pane, click Save.
3. On the Save page, in the Save AutoRecover information every box,

specify the frequency (in minutes) at which you’d like Word to save the
document.

| @ SEE ALSO

For information about working with document versions, see
“Compare and merge documents” in Chapter 11, “Collaborate on




documents.” For information about configuring other Word options,
see “Change default Word options” in Chapter 16, “Customize
options and the user interface.”

Save documents in other formats

Word 2016 uses file formats based on a programming language called Extensible
Markup Language, or more commonly, XML. These file formats, called the
Microsoft Office Open XML Formats, were introduced with Microsoft Office
2007.

Word 2016 offers a selection of file formats intended to provide specific
benefits. Each file format has a file name extension that identifies the file type to
the system. The file formats and file name extensions for Word 2016 files
include the following:

m Word Document (.docx)

m Word Macro-Enabled Document (.docm)
m Word Template (.dotx)

m Word Macro-Enabled Template (.dotm)
m Word XML Document (.xml)

Other file types that are not specific to Word, such as text files, webpages, PDF
files, and XPS files, are available from the Save As dialog box.
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You can save a document in any of these file formats

The default file format for files created in Word 2016 is the .docx format. which
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provides the following benefits over the doc file format that was the previous
standard:

m Decreased file size Files are compressed when saved, decreasing the
amount of disk space and bandwidth needed to store and transmit files.

m Simpler retrieval and editing of content XML files can be opened in
text-editing apps such as Notepad.

B Increased security Personal data can be located and removed from the
document, and files can’t store macros. (The .docm file format is designed
for documents that contain macros.)

If you want to save a Word document in a format that can be opened by the
widest variety of programs (including text editors that are installed with most
operating systems), use one of these two formats:

m Rich Text Format (*.rtf) This format preserves the document’s
formatting.

m Plain Text (*.txt) This format preserves only the document’s text.

If you want people to be able to view a document exactly as it appears on your
screen, use one of these two formats:

m PDF (.pdf) This format is preferred by commercial printing facilities.
Recipients can display the file in the free Microsoft Reader or Adobe
Reader apps, and can display and edit the file in Word 2016 or Adobe
Acrobat.

m XPS (.xps) This format precisely renders all fonts, images, and colors.
Recipients can display the file in Microsoft Reader or the free XPS Viewer

app.

| @TIP

Another way to create a PDF file or XPS file is by selecting that
option when sending the document by email. For more information,
see “Print and send documents” in Chapter 12, “Finalize and
distribute documents.”

The PDF and XPS formats are designed to deliver documents as electronic
representations of the way they appear when printed. Both types of files can
easily be sent by email to many recipients and can be made available on a
webpage for downloadlng by anyone who wants them. However, the files are no
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longer word documents. A PDF Tlle can be converted to the editable word
format. An XPS file cannot be opened, viewed, or edited in Word.
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You can create a PDF file from all or part of a document

When you save a Word document in PDF or XPS format, you can optimize the

file size of the document for your intended distribution method—the larger

Standard file size is better for printing, whereas the Minimum file size is suitable

for online publishing.

Maintain compatibility with earlier versions of Word

Word 2003 and earlier versions of Word used the .doc file format.
You can open .doc files in Word 2016, but some Word 2016
features will be unavailable.

When you open a file created in Word 2010 or an earlier version of
Word, the title bar displays [Compatibility Mode] to the right of the
document name. You can work in Compatibility mode, or you can
convert the document to Word 2016 format by clicking the Convert
button on the Info page of the Backstage view, or by saving a copy
of the document with Word Document as the file type.

If you work with people who are using a version of Word earlier
than Word 2007, you can save your documents in a format that they
will be able to use by choosing the Word 97-2003 file format in the
Save As Type list, or they can install the free Microsoft Office




Compatibility Pack for Word, Excel, and PowerPoint File Formats
from the Microsoft Download Center (located at
download.microsoft.com). The Compatibility Pack doesn’t provide
additional functionality in the older versions of the apps, but it does
enable users to open current documents, workbooks, and
presentations.

To save part or all of a document in PDF format

1. Open the Save As dialog box. In the File type list, click PDF. The dialog
box content changes to provide additional options.

2. If you want to create a PDF file that has a smaller file size (but lower
quality), click Minimum size (publishing online).

3. To modify any of the default settings, click the Options button, do any of
the following, and then click OK:

* Specify the pages to include in the file.
* Include or exclude comments and tracked changes.

* Include or exclude nonprinting elements such as bookmarks and
properties.

* Select compliance, font embedding, and encryption options.

4. If you don’t want to automatically open the new PDF file in your default
PDF viewer, clear the Open file after publishing check box.

5. In the Save As dialog box, click Save.

Close documents

Every time you open a document, a new instance of Word starts. When you
close the file, you can exit that instance of Word. If you have only one document
open, you can close the file and exit Word, or you can close the file but leave
Word running.
To close a document

1. Do any of the following:

* At the right end of the title bar, click the Close button to close the
document and the Word window.

* Display the Backstage view, and then click Close to close the document
without exiting Word.

* On the Windows taskbar, point to the Word button to display thumbnails



of all open documents. Point to the thumbnail of the document you want
to close, and then click the Close button that appears in its upper-right
corner.

Skills review
In this chapter, you learned how to:

m Create documents

m Open and move around in documents

m Display different views of documents

m Display and edit file properties

m Save and close documents

Practice tasks

The practice files for these tasks are located in the Word2016SBS\Ch02 folder.
You can save the results of the tasks in the same folder.

Create documents
Perform the following tasks:

1. Start Word and create a new, blank document.

2. Display the available templates for new documents. Scroll through the list
of featured templates and note the types of documents you can create from
them.

3. Search for a template that is related to something you’re interested in. (For
example, you could use a search term such as food, school, children, or
customers.)

4. Review the categories in the right pane of the search results. Filter the
results by two categories and notice the effect. Then remove one of the
category filters. Preview a template from the search results. If the template
preview includes multiple images, preview each of those by clicking the
arrows below the image.

5. Without closing the preview window, preview the next or previous
template by clicking the arrows to the sides of the preview window.

6. From the preview window, create a document based on the currently



displayed template. Notice that the unsaved blank document remains open.

7. Close the blank document without saving it. Leave the template-based
document open for use in a later set of practice tasks.

Open and move around in documents
In Word, perform the following tasks:

1. Display the Open page of the Backstage view.

2. If there are files in the Recent list, notice the groups they’re divided into,
their file storage locations, and whether any are pinned to the list.

3. From the Open page, browse to the practice files folder, and open the
NavigateFiles document.

4. In the second line of the document title, click at the right end of the
paragraph to position the cursor.

5. Use a keyboard method to move the cursor to the beginning of the line.

6. Use a keyboard method to move the cursor to the beginning of the word
Regulations.

7. Use a keyboard method to move the cursor to the end of the document.

8. Use the scroll bar to move to the middle of the document.

9. Use the scrollbar to change the view of the document by one screen.
10. Open the Navigation pane.

11. In the Navigation pane, click the Landscaping heading to move the cursor
directly to the selected heading.

12. At the top of the Navigation pane, click Pages. On the Pages page, scroll
through the thumbnails to review the amount of visible detail, and then
click the thumbnail for page 5 to move the cursor directly to the top of the
selected page.

13. At the right end of the Navigation pane title bar, click the Close button
(the X) to close the pane.

14. On the Open page of the Backstage view, pin the NavigateFiles
document to the Recent list.

15. Close the document without saving it.

Display different views of documents

Open the DisplayViews document in Word, and then perform the following



tasks:

1. If the document is not already in Print Layout view, display it in that view.

2. Switch to Web Layout view and scroll through the document to the end.
Notice that the lines break differently and that there are no longer any page
breaks.

3. Move the cursor back to the beginning of the document, and switch to
Read Mode view.

4. On the Read Mode toolbar, click Tools to review the commands on the
menu, and then click View to review the commands on that menu. Then,
on the View menu, click Edit Document to return to Print Layout view.

5. In Print Layout view, hide the white space between pages. Scroll through
the document and notice the change in the page lengths when the white
space is hidden.

6. Open the Navigation pane and display the document headings. Adjust the
pane width to the minimum necessary to display the headings.

7. Close the Navigation pane.

8. In the Word Options dialog box, set the width of the style area pane to
2”. Then click OK to return to the document.

9. Display the document in Draft view. Notice that the style area is visible
along the left side of the document, but it is wider than necessary.

10. Drag the style area pane’s right border to the left until it takes up about
half the original amount of space.

11. Display the document in Print Layout view, and use any method described
in this chapter to change the magnification to 75%.

12. Split the window into two panes, position the cursor in the top pane, and
then change the magnification to 100%. Notice that only the active pane
changes. Then remove the split.

13. Use commands on the View tab to arrange the DisplayViews document
and the document you created in the first set of practice tasks side by side
on the screen.

14. In the DisplayViews document, display the gridlines. Notice that they
appear in both open documents.

15. Switch to the document you created in the first set of practice tasks.
Display the rulers. Notice the effect of this action in the other open
document.

a~ o~



16. Save and close both documents.

Display and edit file properties
Open the EditProperties document in Word, and then perform the following
tasks:

1. On the Info page of the Backstage view, do the following:

* Review the information in the Properties list. Notice the types of
information that have been saved with the document.

* Point to each of the property values, and notice the values that you can
edit.

* Set the Title property to Welcome to Word.

2. Expand the Properties list to display all properties, and then do the
following:

* Notice the additional properties that were not previously visible. (If
necessary, click Show Fewer Properties to switch back to the original
list for comparison purposes.)

* Point to the Manager and Author property values, and notice that Check
Names and Address Books buttons appear. Experiment with adding a
Manager property from your address book.

3. Click the Properties header, and then display the advanced properties. In
the EditProperties Properties dialog box, do the following:

» Compare the properties on the Summary tab with those in the
Properties list. Notice the properties that you added in steps 1 and 2.

* In the Author box, enter your name.
* In the Keywords box, enter Word 2016 new features.

* Review the information on the General, Statistics, Contents, and
Custom tabs. Notice the information that is available only in the
Properties dialog box.

* Click OK.

4. Verify that the information you entered in the Properties dialog box
appears in the Properties list. If it doesn’t, save, close, and reopen the
document to update the properties.

Save and close documents
In Word, perform the following tasks:



1. Save a copy of the EditProperties document in the practice file folder as
MyDocument. Close the document and this instance of Word.

2. Close the document you created in the first task without exiting Word.
3. Close the remaining open documents, and exit Word.



